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Owner’s Record
For your convenience, record the serial
number located on the bottom of 
the drive in the space provided below.
Please refer to it when you contact 
your Imation dealer in case of  difficulty.

Serial No.____________________________

SuperDisk™ USB Drive for Macintosh
User’s Guide



Trademarks

Imation, the Imation logo, SuperDisk and the SuperDisk logo are trademarks of Imation
Corporation. All other trademarks are the property of their respective owners.

Copyright

© 1999 Imation Corporation. All rights reserved.

Intended Use

This guide shows how to install and use the Imation SuperDisk USB Drive on an Apple
Macintosh™ computer.
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Welcome to Imation

Thank you for purchasing an Imation SuperDisk™ USB drive for Macintosh. 
This drive uses the latest USB technology and is fully hot-pluggable to an
iMac™ or other Macintosh with native USB support. Hot-pluggable means you 
can connect or disconnect your SuperDisk drive anytime you wish without turning 
off your computer. 

Your new drive is both high-capacity and floppy-compatible. 
It can use both Macintosh and PC-formatted 120MB SuperDisk diskettes 
and regular 2HD diskettes. 

You can use your new drive to perform all of the following:
• store data and organize large files with 85 times the capacity 

of conventional diskettes
• transfer large files and share data with other computers—

both Mac and PC
• download from the Internet
• back up and restore important files and folders
• create space by archiving files on your hard drive  
• protect private information on a personal SuperDisk diskette
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Note:

Getting Started

1 Make sure the following items are included in your box:

• Imation SuperDisk USB drive
• Auto-switching power supply and cord 
• USB interface cable
• Installation CD-ROM (containing driver software and this guide) 

2 Make sure you have an iMac or Macintosh with all of the following:

• Mac OS™ 8.1 or higher
• Available USB port
• CD-ROM drive
• 16MB of RAM
• 5MB of available hard disk space 
• For iMacs only:

➥  iMac Firmware Update 1.0
➥  iMac OS Update 1.0 (if your Mac OS is 8.1) or iMac OS Update 1.1

(if your Mac OS is 8.5.x)

For more information, visit 
http://support.info.apple.com/support/imac/index/html

3 Read the following tips to get the best results from your SuperDisk drive: 

Diskettes

• Use Imation SuperDisk diskettes for Macintosh. Supported Mac and PC diskette types 
are listed in Specifications. 800KB and 400KB Mac format diskettes do not 
work in this drive.



Getting Started

Compatibility issues

• Before installing your drive, disable any security software (for example, Onguard™ or 
At Ease™) installed on your computer. Remember to enable this software after drive 
installation is complete. For more information, see your security software manual.

Safety—follow laser safety guidelines at the end of this guide.

Using your drive

• Always eject any diskette from your SuperDisk drive before disconnecting the drive 
from your computer. Doing so may prevent data loss.

• Never remove a diskette from your SuperDisk drive while your drive is making an 
operating sound or the green activity light is lit or blinking.

• Always operate your drive indoors where it’s dry. Make sure the drive rests 
on a flat surface.

4 To keep up-to-date with product and software news, visit our web site.
Make sure to register your drive on-line by following the links at:

http://www.imation.com/register/
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1 Make sure your SuperDisk drive is not connected.

2 Carefully insert the installation CD-ROM printed 
side up into its drive tray and close the tray.

3 Double-click the CD icon. After a few seconds, 
the CD window opens.

4 Double-click the SuperDisk Installer icon.

5 The installer program displays this introductory screen. 
Click Continue.

Installing driver software

If your computer is a new-generation iMac or Macintosh G3, it comes with driver
software pre-installed. You can skip to Connecting the SuperDisk drive if you wish.
However, if you don’t have a new-generation computer, or if you want to make sure
your new-generation computer has the most recent driver
(www.imation.com/superdisk/), perform the following:
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6 Software license agreement information appears. Read it and click Continue.

7 This USB driver screen appears. Read it and click Install to load version 
1.31 onto your hard drive.

The installer program searches for any previously installed driver and 
determines whether it’s more recent then the one you’re presently installing.
If it is, the installer program prompts:

No installation was necessary. The files to be installed are 
already on your disk, or are not needed for your hardware setup.

Click Quit to exit from the installation process. Skip to Connecting your 
SuperDisk drive.

Installing driver software
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8 This warning screen appears, reminding you to restart your computer when 
installation is complete. Click the Continue button on the right.

9 This screen appears, telling you driver software installed successfully. 
Remember to click the Restart button on the far right.

Installing driver software

6
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Connecting your SuperDisk drive

1 Connect the USB cable to the rear of your SuperDisk 
drive. Do this by squeezing the cable end together 
to separate its prongs.Then push the cable firmly 
onto your drive’s connector. Release the sides to lock 
the cable in place. 

2 Plug the power cord (round end) into the rear of your 
SuperDisk drive and plug the other end of the power 
cord into a power outlet.

3 Plug the other end of the USB cable into an available 
USB port on your computer, keyboard, or hub.

4 Insert a diskette into your SuperDisk drive.

5 After a few seconds, the diskette icon displays on 
your desktop. Its appearance varies according to 
your operating system version and diskette type.

Your SuperDisk drive installation is complete!
You’re now ready to use your drive.



Using your SuperDisk drive

Once you insert a SuperDisk or HD diskette into your drive, the diskette 
icon on your desktop operates just like your hard disk icon. You can 
drag-and-drop files to the diskette icon to move or copy files or folders. 
Just double-click the icon to see the files and folders on the diskette.

Ejecting Diskettes

There are three ways to eject a diskette:

1 Drag the icon to the trash icon.

2 Press the apple z and E keys at the same time.

3 Manual eject—if the diskette appears stuck or your drive does not have 
power, straighten out a paper clip, insert it into the small hole in the 
center of the Eject button, and gently push it in until the diskette ejects.
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Using your SuperDisk drive

Formatting Diskettes

To format or erase a diskette:

1 Insert a diskette into the SuperDisk drive and click on the diskette icon.

2 Turn off File Sharing from Control Panels (only when formatting a diskette).

3 Choose Erase Disk from the Special menu in the Finder.

4 Select one of the formatting options from the menu (for example, Mac OS 
Standard, Mac OS Extended, or DOS). 

Select the DOS formatting option for 1.4MB and 720KB diskettes only. 
Do not reformat SuperDisk diskettes to DOS format. 
See Troubleshooting for more information.

5 Click Erase. 

Erasing a diskette may change your SuperDisk diskette icon’s appearance.
For more information on how to restore the icon, seeTroubleshooting.
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Cleaning your SuperDisk drive

Clean your SuperDisk drive after every 40 to 80 hours of operation, depending 
on the cleanliness of your operating environment. Head cleaning is an easy and
effective way to prevent data loss. This does not mean the drive won’t work if it 
isn’t clean; it is only recommended to ensure optimum drive performance. 
Think of head cleaning as preventive maintenance—a clean head means less 
trouble later on.

Use only Imation’s LS-120 or SuperDisk Head Cleaning Kit. Because of 
potential damage to the drive’s head, use of any other head cleaning kit 
voids your warranty. Do not use a standard diskette head cleaning kit.

The Imation LS-120 SuperDisk Head Cleaning Kit is available through your 
retailer or Imation Internet store (US only): store.imation.com

Warning!
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Troubleshooting your SuperDisk drive

Your SuperDisk drive is designed to provide years of service. If you encounter problems,
they may be due to a dirty drive head or improper installation.

Take the time to read through this section. For your convenience, additional information 
is available on the Imation web site (www.imation.com/superdisk/):

• more troubleshooting solutions
• common “how to” tips
• frequently asked questions (FAQs)

After I format a SuperDisk diskette in DOS, I cannot read the diskette on a PC.

Mac OS 8.1:
PC Exchange version 2.2 or earlier does not format SuperDisk diskettes correctly.
To restore a PC-formatted diskette to Mac format:

1 On the Apple icon in the Finder, click Control Panels > PC Exchange.

2 Click the Off button.

3 Insert the diskette into a drive. 

4 Reformat the diskette into Mac format.

Mac OS 8.5:
File Exchange does not format SuperDisk diskettes correctly. You may not be able 
to restore a PC-formatted SuperDisk diskette to a Mac format or interchangeable 
PC format. Avoid using the DOS format option.

The SuperDisk diskette icon does not display on my desktop after I insert a diskette 

into the drive.

1 Make sure you inserted a readable diskette into the SuperDisk drive.

2 Make sure all cables are securely connected.

3 Make sure the computer and drive have power.

4 Eject and reinsert the diskette.

5 If the icon still doesn’t appear, reset the drive:



Troubleshooting your SuperDisk drive

a Unplug the SuperDisk drive’s USB cable from your computer’s USB port.

b Unplug the power cable (round end) from your SuperDisk drive and wait 
five seconds.

c  Reconnect the power cable.

d Press Eject to remove any diskette from the drive.

e Reconnect the USB cable.

f Insert a good diskette (regular or SuperDisk) into your SuperDisk drive. 

The diskette resets the drive. If it does not, repeat steps a-d, restart your computer, 
and continue with steps e and f.

The SuperDisk diskette icon appears in black and white instead of gray.

This only occurs with Mac OS 8.1 after you erase a SuperDisk diskette.
To restore the icon’s appearance, perform the following:

1 Click the SuperDisk diskette icon on your installation CD-ROM.

2 Choose Get Info from the File menu under the Finder.

3 Select the diskette icon from the window and choose Copy from the Edit menu.

4 Click the SuperDisk diskette icon on your desktop.

5 Choose Get Info.

6 Select the diskette icon from the window and choose Paste from the Edit menu.
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Troubleshooting your SuperDisk drive

I need to un-install driver software.

1 Double-click your hard drive icon. Click System Folder > Extensions.

2 Find these files and drag them to the trash icon.
USBSuperDiskDriver
USBSuperDiskUTDriver

3 Empty the trash.

My drive cannot read diskettes after I install driver software and connect the drive.

1 Make sure you are using a fully supported diskette. See the Diskette Types table 
in Specifications.

2 Eject and re-insert the diskette.

3 Disconnect and reconnect the power cord plug from the back of the 
SuperDisk drive.

4 Disconnect and reconnect the USB interface cable from the back of your drive.

“The Software needed to use the device ‘E-USB Bridge’ cannot be found. Please refer 

to the device documentation to install the necessary software” appears after I restart 

my computer.

This message appears if you have Mac OS 8.1 and you have turned off extensions 
and disabled drivers. Perform the following:

Solution 1: Install driver software if needed and not already installed.
Solution 2: Make sure to turn extensions back on before connecting the SuperDisk drive. 

Perform the following:

1 Click Apple icon > Control Panels > Extensions Manager.

2 Place a check beside these files:  
USBSuperDiskDriver
USBSuperDiskUTDriver

3 Click Restart.



Troubleshooting your SuperDisk drive

My SuperDisk drive reads regular diskettes but not SuperDisk diskettes.

Clean your drive using the following methods:

1 Imation LS-120 or SuperDisk Head Cleaning Kit to clean your drive’s head.

2 Compressed, canned air to clean your drive’s optics. Do not insert the air can tube 
deep into the drive slot.

Contact Imation technical support if the problem persists.

My SuperDisk drive doesn’t work with PC emulation software.

Virtual PC™ and Soft Windows™ require updates that you can obtain from your software
vendor. PC emulation software typically supports only internal floppy drives, hard drives,
and CD-ROM drives.
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Specifications

Operating Position: Horizontal Only
Transfer Rate: Up to 40MB per minute with a SuperDisk diskette

Temperature Range 

(Use in a non-condensing atmosphere)

Power (indoor use only—in dry area)

Size

Diskette Types (3.5”)

15

Operating 40˚ to 104˚F  5˚ to 40˚ C

Non-operating -22˚ to 140˚ F -30˚ to 60˚C

Mac format

PC format

Mac format

PC format

Mac format

PC format

SuperDisk

2HD

800KB/400KB

2DD 

Diskette Type   Mac/PC Read/Write   Format Diskette Used

✓

✓

✓

✓

Ø

✓

✓

Ø

✓

✓

Ø

✓

Length  71/2 inches    190 mm

Width     51/4 inches   133 mm

Height    2 inches 38 mm

120MB PC (IBM) format SuperDisk diskettes

120MB Mac OS format SuperDisk diskettes

1.4MB Mac format 3.5” 2HD diskettes

1.4MB IBM Mac format 3.5” 2HD diskettes

NOT SUPPORTED

720KB IBM format 3.5” 2DD diskettes



Regulatory Information

Laser Safety

The Imation SuperDisk drive contains a Class 1 laser that produces visible laser light at an
intensity of up to 7 milliwatts (at 633 nanometers). Special precautions have been taken in
the design of the disk drive to ensure that the operator will not be exposed to the laser light.
Avoid looking directly into the laser beam path or any reflection of it. Laser light of this 
intensity can cause serious eye damage.

Complies with IEC 825-1 and EN60825-1 as a Class 1 LASER Product.

Class 1 laser products are not classified as being hazardous. However, to ensure safety 
consistency over the entire product life cycle, the following precautions should be 
considered:

1 Use of controls or adjustment of procedures other than those specified herein may result 
in hazardous radiation exposure.

2 The drive is designed to be incorporated within the Imation external enclosure.
It is not designed to be used without an enclosure.

3 Do not open the external drive housing. There are no user adjustments or maintenance 
parts inside. 
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Regulatory Information

United States FCC Information

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, try to correct the interference by one or
more of the following measures:

1 Reorient or relocate the receiving antenna.

2 Increase the separation between the equipment and the receiver.

3 Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected.

4 Consult the dealer or an experienced radio or television technician for help.

Canadian Notice

This class B digital apparatus meets all requirements of Canadian Interference-Causing
Equipment Regulations.

Avis Pour Le Canada

Cet appareil numériqe de la classe B respecte toutes les exigences du Réglement sur le
matériel brouilleur du Canada.
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European Electrical Conformity

This equipment fully complies with the European CE requirements specified in the EMC
Directive 89/336/EEC and the Low Voltage Directive 73/23/EEC. See the following Declaration
of Conformity:

Declaration of Conformity 

98/336/EEC,73/23/EEC Application of Council Directive(s)
EN55022, EN60950 Standard(s) to which Conformity is declared
EN50082-1
IEC1000-4-2
IEC1000-4-3
IEC1000-4-4

Manufacturer’s Name: Imation Enterprises Corporation
Manufacturer’s Address: 1 Imation Place

Oakdale, MN 55128-3414

European Location of Declaration of Conformity
Imation Deutschland GmbH
Hammfelddam 11*D-41460 Neuss

Type of Equipment: Information Technology Equipment

This is to serve as official notification to our European Partners that the following product
fully complies with the European CE requirements specified in the EMC directive 89/336/EEC 
and the Low Voltage Directive 73/23/EEC.

Model: SuperDisk USB Drive™ for Macintosh 2



Limited Warranty

LIMITED WARRANTY AND LIMITATION OF REMEDIES:

Imation warrants that this product is free from defects in material and manufacture at the
time of purchase. If any such defect appears within twelve (12) months from the date of 
purchase, Imation’s entire liability is either a) repair, or b) replacement of the product, or c)
refund of the purchase price of the product, which must be returned to Imation with proof 
of purchase. This warranty does NOT apply to product failure resulting from misuse, abuse,
accident, neglect or mishandling, improper adjustment or maintenance, incorrect 
environments or wear from ordinary use. 

IMATION SHALL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL,

OR CONSEQUENTIAL LOSS OR DAMAGE (INCLUDING WITHOUT LIMITATION DAMAGES

FOR LOSS OF PROFITS, SAVINGS OR DATA) IN ANY WAY RELATED TO THE PRODUCT.

This does not exclude claims for personal injury. Some legal systems do not allow 
limitations on how long an implied warranty lasts or the exclusion or limitation of 
incidental or consequential damages, so the above limitation or exclusion may also apply 
to you. This warranty gives you specific legal rights, and you may also have other rights
which vary depending upon the legal system is applicable to your purchase and/or use of
the product. 

For technical support and service information, see the next page.
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Imation Technical Support

Imation provides free support on the Internet and via e-mail.  There may be a basic 
charge for phone consultations and solutions to installation and operator problems.

If you need to contact Imation, please include the following information or have it ready
before you call:

✔ Drive model (for example, internal, USB, parallel port)
✔ Drive serial number (located next to bar code on drive)
✔ Date of purchase
✔ General computer information

• Operating System
• Brand and model of computer
• Other hardware included on your system (for example, internal CD-ROM drive, 
• other storage devices)
• Brand and model of printer (if the printer is connected via your parallel port)

Telephone Support:
US & Canada 1 800 888-2700
Australia 1 800 244 181
New Zealand 0 800 445 922
Latin America 1 651 704-7222

Europe

Belgium (French) +32 [0] 2720 61 51
Belgium (Flemish) +32 [0] 2720 4800
France +33 [0] 1343 55533
Germany +49 [0] 2131 226 01
Italy +39 [0] 2753 83972
Netherlands +31 [0] 065 42141
Spain +34 [9] 134 32640 
United Kingdom +44 [0] 1344 862201

Asia

Hong Kong 852 2571 2000
Singapore 65 3837 651

For telephone support numbers in other countries and for fax numbers, please check the
README file on the installation CD, the Imation web site (www.imation.com), or contact
Imation in the United States at:

General Information

US & Canada 1 888 466-3456
Outside US & Canada 1 651 704-7229

FAX

US & Canada 1 888 704-7100
Outside US & Canada 1 651 704-7121

Web Site (FAQ’s) www.imation.com/superdisk/

E-mail info@imation.com
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